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1. OVERVIEW

The Advance time switch is a programming clock which enables the automatic switching
ON-OFF different loads on the basis of a timed programming that is sufficiently flexible to
allow or exclude the activation depending on the day of the week.

Following product variants available in each single channel and Double channel configuration.
For detailed description along with CAT ID refer below table.

Digital Time Switch Crono Pro
Digital Time Switch Astro Pro+

Digital Time Switch Astro Pro

) Crono Pro Astro Pro+ Astro Pro
Functions I S DS [WT2DCDS | AT1SCDS | AT2DCDS | AS1SCDS | AS2DCDS
Relay Output 1 2 1 2 1 2
S”p?\'/yA\C/())'tage 240 |110-240| 240 |110-240 | 240 |110-240
Astro - - - - v v v v
Multifunction v v v v - - - -
Cycle v v v v - - --
Pulse v v v v - - - -
Time Switch v v v v - - - -
Lat/Long - - - - v v v v
City - - - - v v v v
Program
Memory 50 50 50 50 50 50
(Per channel)
E'fo';gdrg\r’n 10 10 10 10 10 10




(L) ASTRO PRO

2. FEATURES

e LCD Display with green backlight

e Precise time programming for Daily / Weekly /Pulse /Astro switching

e Bar graph for intuitive representation of daily program

e Two separate relay outputs (16A each) with independent programming
e Settable DST feature

e Latitude / Longitude database for 45 countries and 280 cities

e Settable Latitude / Longitude precise to the minute with time zone

e Sunrise/Sunset or Twilight trigger modes
e Password protection for settings
e ZCD assistance for inrush current management and for better relay & load life

e 12/24 hour display format
e Excellent battery backup with 6 years battery reserve
e Simple reset & Manual override

e Monitoring of load service hours to display alarm and plan maintenance/other activity

i Astro Prp
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3. CONNECTION DIAGRAM

A) 1 Channel Device B) 2 Channel Device
L 15 L 15 25
240V 110-240V
AC &18 AC &H1s| & 28
N 16 N 16 26

RECOMMENDED CONNECTION

A) 1 Channel Device B) 2 Channel Device

N

RN WN = [E> (OV)

L N 28 29 @6 (L)
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C A VvV Jd C A VvV Jd
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18 @5 ae 18 @5 ae) (N)
$ N 1 N
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NOTE-

. For relay connection, use same phase supply which is used for device supply.

E.g. If device supply is connected to R Phase and Neutral, then same R phase should
be used for relay connection also. Refer above connection diagram.

In order to avail ZCD feature which is useful for Load life, Do not interchange Line and
Neutral connections while connecting supply to Device .

. Line should be always connected to L and Neutral to N of device.

CAUTION:

. Always follow instructions stated in this product booklet.

Before installation, check to ensure that specifications agree with intended application.
Installation must be done by skilled technician.

. Automation and controlled devices must be properly “installed” so that they are

protected against any risk of involuntary actuations.

RoHS
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4. MOUNTING DIMENSION

45

5
N
(|
Lﬁ
492
66.2

90

Note- All dimensions are in mm

TERMINAL TORQUE & CAPACITY

0.5 N.m (4.4 Lb.in)

@ 4.5 mm
f S — 1 x 4.0 mm? Solid/Stranded Wire
AWG 26 to 10




5. OPERATING MODES

1) ASTRO MODE:

1. It allows user to program the output as per Sunrise and Sunset time along with OFFSET
time if required.

2. User can also program output OFF time during execution of ASTRO program.

2) PERMANENT SWITCHING:
1. This mode allows User to make output permanently ON or OFF.
2. The output will remain in this mode till User deactivate the mode.

3) TEMPORARY OVERRIDE:
This mode allows User to override current state of output.
E.g. If current state of output is ON then using override mode User can change the

output state to OFF (or vice a versa) till execution of next scheduled program.

4) PRIORITIES:
In case of multiple programs calls action on output at same time, it will be operated as
per following priority,

PERMANENT OFF
PERMANENT ON
OVERRIDE
HOLIDAY OFF
HOLIDAY ON
PROGRAM OFF
PROGRAM ON

NomhWN=




6.DISPLAY

6.1. Display Description

For symbols
refer Table 1

AL

For keys
refer Table 2

SYMBOL DESCRIPTION
> Bar Graph :
> It consist of 48 segments which indicates 24 hours of
a day with a resolution of half hour.
> ON segment in Bar graph indicates that output will
be ON at that time of the day. Also it indicates menu
depth in menu/edit mode.
> It is updated whenever day changes or at program edit.
a > Display current weekday on main screen and menu name
during program.
e > Display current date on main screen and menu setting
mode during program.
o > Display current weekday in menu setting and also for
main screen.
e > Display current time.

|—6




Table 1

SYMBOL DESCRIPTION
CH1 > Display output channel number.
CH2 > For 2 Channel product, display toggles between CH1 and CH2
number after every 7 sec with 5 sec ON and 2 sec OFF time.
_./‘_ » Display relay status ON/OFF of respective channel CH1 or CH2
Ea > Indicates that output is ON/OFF due to Temporary Override
mode.
L . .
O|‘| > Indicates that output is ON/OFF due to Permanent mode.

\4

Indicates that output is ON/OFF due to Holiday program.

Indicates that output is ON/OFF due to Time Switch mode.

Indicates that output is ON due to Pulse or Cyclic mode.
Pulse mode is indicated by single pulse.
Cyclic mode is indicated by dual pulse.

Indicates that output is ON/OFF due to Astro mode.

—
—1
V|V V V|V

> Blinking indicates DST is applied.
s/ » Indicates day and night time.
P (S > Sun indicates day time.
» Half moon indicates night time.
6.2 Key Operations Table 2

To enter the menu.

To return to main screen or previous menu.

To abort changed value or parameter.

To view parameters upward.

To change/increment parameter value in edit mode.

To view parameters downward.
To change/decrement parameter value in edit mode.

C
o
V |VV|VV|IVVY

To select and save parameter value in edit mode.

> It is small key located in between Up and Down key.
> To reset hardware when device doesn't respond or hangs.
> It doesn't change any of the user settings and clock.

RESET O

6.3 Combined Key Operations for temporary override mode

» Pressing both keys together will change the present output

@ + @ state of Channel 1.
> Repressing both keys together again will restore the output

state of Channel 1.

» Pressing both keys together will change the present output

+ state of Channel 2.
> Repressing both keys together again will restore the output
state of Channel 2.

» Temporary Override is deactivated by using same hot key or next program event.

e, )




7. MAIN MENU

> Press ESC 9 key to enter in to Main menu.
> Press Up A Down ¥ key to select menu.
> Press Enter & key to select sub menu.

0,6 , 12,18 , 24 0 , 6 , 12,18 | 24 0,6 12,18 | 24 0,6 , 12,18 , 24

O A V J O A V J

0,6 , 12,18, 24 0,6 12,18, 24 0,6 12,18, 24

OA V J OA V J O A V J

NOTE !- In edit mode, If no push button is pressed for 40 seconds, device exit from edit
mode.




7.1 PROGRAM

VYV Vvvy

0 , 6 , 12,18 | 24

\J C/

O A V J

There are 6 sub menu under Program Main Menu.
Channel -> New -> View->Modify -> Delete -> End

0 , 6 , 12,18 | 24

0,6 12,18 | 24

OA VvV J

0,6 12,18 | 24

Program Menu is used to write new programs for selected channel.
Channel selection is only available for two channel device.
Using Up A Down ¥ key select Channel CH1/CH?2.

User can also View, Modify, Delete existing program.

0 ,6 , 12,18 | 24

oA VvV J

0 [ 6, 12,18 | %

0,6 , 12,18, 24




7.1.1 New

Flow to Write New Program Astro

AV [CHAN
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> Press ESC 9 to enter programming ( Edit) mode.

> Change parameter value or status by pressing Up A and Down V¥ key.

> After changing parameter value press Enter «d key to accept value of parameter and
move to next digit or parameter.

> Enter Offset morning time which is before/after sunrise (+/- respectively).

> Enter Offset evening time which is before/after sunset (+/- respectively).

> Then select "OFF hour Enable/Disable” option. If Enable, enter OFF Hour for turning
output OFF for specific hours.

> If select NO for ‘With Date’ option then program get savedwithout date and operate as

weekly time switch.
> After completion of parameter editing, press Enter «d key to save all parameters.
» As per above procedure other programs can be enter and saved.

NOTE ! - 1. Channel selection option only for 2 channel device.
2. By default whole week is selected for Start day selection.
3. To deselect any weekday press downV key and to select any weekday press
up A key.




7.1.2 View
To verify, the switching times have been correctly programmed use this sub menu.

AV | CHANNEL ciocz
VTN | > Use Up A Down V¥ key to select the channel.
FRO 3 «d > Use Up A Down W key to select the program number.
» Then press Enter J key to check all settings one by one.
7.1.3 Modify

The program can be modified in this sub-menu.

AV | THANNEL crce| > Use Up A Down V¥ key to select the channel.
' Py R » Use Up A Down V¥ key to select the program number.

> Then press Enter J key to confirm program to be modified.

» As per program type, Set new values as per subsection
7.1.1.NEW.
> By pressing Entered key modified program get saved.

7.1.4 Delete

To delete single or multiple programs use this sub menu.

Use Up A Down W key to select the channel

Use Up A Down ¥ key to select single delete or multiple

delete program.

Use Up A Down ¥ key to confirm delete with No/Yes

option.

| ol Then press Enter«Jd key selected program will be
ND/YES deleted for single delete and if selected multiple delete

] then all programs will be deleted.

] > To abort Delete option, press ESC ‘O key.

AV | CHANNEL cice| o

™
-
™
t
V. V VYV

7.1.5 End

> By using this menu, direct go to Main screen.
» To go to previous menu, use ESC9 key.

—_—




7.2 CLOCK

» Second option is Clock Menu which is used for various clock settings.
> Ensure that before clock setting respective country’s time zone/Location is set.

0,6 , 12,18 | 24

There are 8 sub menu under Clock Main Menu.
Date/Time -> Time Format -> Date Format -> Week Start Day ->
Location ->Twilight -> DST -> End

OA V J

0,6 12,18 | 24 0 , 6 , 12,18 | 24 0,6 , 12,18 , 24 0,6 12,18 | 24

0,6 12,18 | 24

0,6 12,18 | 24 0,6 , 12,18 , 24 0,6 , 12,18 | 24

S A VJ O A V J

7.2.1 Date/Time

Date/Time menu is used to set Date and Time manually.

IRTE/TIME | 4 > Use Up A Down V¥ key to select the parameter value.
YEHK R » Then press Enter<d key to save parameter and go to
MONTH k= next parameter setting.
v
HHHl"“‘R |‘J|d > After setting, press enter & key to save date and time.
[y
| MINUTE =
] SAVETD

NOTE !- This setting reflects on main screen display and in Program setting.

_—




7.2.2 Time Format

Time Format is used to set time format either 24 hours or 12 hours (AM/PM).

TIME FORMRAT | Y > Use Up A Down V¥ key to select the time format.
R P AV > Then press Enter «J key to save format.
GAVET d

7.2.3 Date Format

For date format setting, Worldwide 3 different formats are usual, as listed below.

v > Use UpA Down ¥ key to select the date format as listed below.
T o DD:MM:YY , Ex- 08-07-20

MM:DD:YY , Ex- 07-08-20

YY:MM:DD , Ex- 20-07-08
» Then press Enter e key to save format.

7.2.4 Week Start Day
This menu is used to set start day of week.

> Use Up A Down ¥ key to scroll week days and Entered key

WEEK START IRY |
CUNTAY | AV to save week start day.
CAVET o > Select week start day from Saturday to Sunday.

NOTE !- This setting reflects on main screen display and in Program setting.

——— O —




7.2.5 Location
Coordinate menu is used to set location details and time zone.

Country Coordinate
L OrATTONT | <J
] I_H—HTTI—IMT ‘J [y . [ A By
LUt LU | A v —hm mT T ‘J
AV Cr N T OV |‘J v_uuF?_u_LNHAE |
LUy i OIGN LATITUTE |‘J
T,l“l‘nTH |‘J P R A A B L N B )
ENE » DEGREE LATITUIE|
Pl M‘rnul‘rE |H‘|‘TT||‘|‘IE|‘J
SH{/’EB d reLrNes — LI I A )
H GIGN LONGITUDE |
- TEGREE L ONGITUDE
] - MINUTE LONGITUTE S
] - TIME ZONE |
| - SAVET J
Country L
> By Up A Down V¥ key select the country and ]

respective cities. ||
» Then press Enter e key to save format.

Coordinate

>  For Latitude setting, enter sign of Latitude i.e. South or North. Then degree followed
by minute of latitude. Same parameters enter for Longitude for Sign East or West.

» Then select time zone from list, to save setting use Enter key.

» To scroll digit use Up A and down V¥ key.
» For save and update next parameter use Enterd key.

7.2.6 Twilight

» This is energy saving mode. Twilight is the soft glowing light from the sky when the sun
is below the horizon, caused by the reflection of the sun's rays from the atmosphere.

» Even after Sunset, there is sufficient light in the sky & generally there is no need to
switch on Lights/Load exactly at Sunset. So if Twilight feature is used, then light will
get On after some time from Sunset. This time is calculated automatically.

» Thus it saves energy & reduce Electricity bill as well.

TWILIGHT d » Using Up & Down V¥ key scroll enable/disable and EntereJ
ENRBLE | AV key to save.
SRVEE "' ENABLE- Device will operate at [Sunset+Twilight time]

[Sunrise-Twilight time] which saves energy.

L DISABLE- Device will operate as per Sunset/Sunrise time

NOTE !- This setting reflects on main screen display and in Program setting.




7.2.7 DST

» On DST event, date and time automatically get updated.

» User can select DST from options available in menu. User can either select country
or set manually by FIX DST or CUSTOM DST option.
> By using Up A and Down ¥ keys, select required settings and to save press Enter & key.

FIXED DST

-

o5

offset hour range from 1 Minute to 2 Hours.

NO DST
I5T 4

ND DST |A v

SAVET A

> NO DST- No changeover
>
>
>

SELECT COUNTRY- Changeover as per below table.

CUSTOM DST
15T Rs
cusToM 357 |
START MONTH|
START WEEK |«
GTART HMOUR |
] START MINUTE|H
— ENT MONTH |
- END WEEK |
4 L OFFGET HOUR |
L OFFGSET MINUTE
|| SAVED

FIX DST- Changeover as per user set date & time. By default 1 hour offset time.
CUSTOM DST- Changeover as per user set date & time. Here user get access to set

NOTE !- To avoid settings at day changeover, the time 9.01 PM- 11.59 PM is blocked in

setting range.

DST Setting Country Chart

Country | Start Start |Start Start | End End End End | Offset
Month | Week |[Weekday| Time | Month | Week | Weekday| Time | Time
Europe | March | oo | Sunday | 2:00 | October | o | Sunday | 3:00 | 1:00
2nd _ 1st _ .
USA March week Sunday 2:00 |November week Sunday 3:00 1:00
GB/IRL/P March Last Sunday 1:00 October Last Sunday 2:00 1:00
week week
Last . Last . .
FIN/GR/TR| March week Sunday 3:00 October week Sunday 4:00 1:00
CDN April 1st Sunday | 2:00 October | Last Sunday | 3:00 1:00
week week
7.2.8 End

» By using this menu, direct go to Main screen.

>

To go previous menu use ESC key.




7.3 MANUAL

0 | 6 , 12,18 | 24
There are 3 modes under Manual Menu.

» Permanent ON
» Permanent OFF
» Override ON/OFF

O A VY 4] This setting affect on main screen display and in program setting.

Permanent ON Permanent Off Overide ON/OFF

CHRANNEL ricc2 [ CHRANNEL ricca [+ CHANNEL oo |
PERMANENT ON| AV PERMANENT OFF|A v AVERTIC ON/OFFlA W

0 , 6 , 12 , 18 | 24 0 , 6 , 12,18 | 24 0 , 6 , 12,18 | 24

rON DAY MONDA Y MONDA Y

o4 e 18 o4, e 18 o4, 2 iS5

I
A
:O..i
J
w *
ca
"0
..!
)
lEUJ*
>goo
« | 0]
w
L 0

> By using Up A and Down ¥ keys, select required settings and to save press Enter & key.
Channel selection option only for two channel device.

» Once any mode activated, then to deactivate setting user has to goto same menu and
select setting.

» Symbol for particular mode is displayed at bottom row as shown by red circle.
Override ON/ OFF :
This mode allows User to override current state of output.

A\

» When relay is in ON state, Override OFF will appear in manual menu and when relay
is in OFF state, Override ON option will appear in manual menu.

Temporary override can also be achieved by hot keys operation.

> E.g. If current state of output is ON then using override mode User can change the
output state to OFF (or vice a versa) till execution of next scheduled program.

>  After selection display returns to the manual menu window.

v

NOTE ! - Only one Channel (CH1/CH2) symbol will be displayed at a time.

I—']G




7.4 HOLIDAY

> Holiday mode can be set on any channel of the device. Channel output can be set as
ON/OFF during holiday period.

For example- If user select holiday start event at 10:15 of 17" March 2018 and Holiday
end event at 07:00 of 30" May 2018 & select channel action as ON.

Then, Channel output will be ON from 10:15 of 17" March 2018 till 07:00 of 30" May
2018.

CHANNEL selection option only for two channel device.

By using Up & Down V¥Keys select channel CH1/CH2.

» User can also View, Modify, Delete existing program.
0 , 6 , 12, 18 , 24

Ay

Y VvV

N1 TN
HUC LU There are 7 sub menu under Holiday Main Menu.

Chanel Selection->Channel Status-> New -> View-> Modify ->
Delete-> End

A V J
o , 6 , 12, 18 , 24 0 , 6 ;12,18 | 24 0 |, 6 ;12,18 | 24 0 , 6 ;12 18 | 24
CHANNEL CHANNEL S rEL v IEW

C! —>> —>> —>>

O A V J OA V J OA VvV J OA V J

0 6, 12, 18 | 24 0 , 6 , 12,18 | 24 0 , 6 , 12, 18 , 24
End JELETE MODIFY

OA V J OA VvV J OA V J

7.4.1 Channel Status

» By using Up & Down ¥ key status can be changed.
» After selecting press Enter & key to save selected status.

ENABLE -Holiday Program for selected channel will execute as per set.

DISABLE -Holiday feature for selected channel will not available.

17




7.4.2 New

]
[

Lo

CHREN?

|

CHH

[
(A

» Change parameter value or status by pressing UP A and Down 'V key.

> After changing parameter value press Enter & key to accept value of parameter and
move to next digit or parameter.
> After completion of parameter editing, press Enter « key to save all parameters.

» As per above procedure other programs can be enter and saved.

7.4.3 View

To verify, the switching times have been correctly programmed use this sub menu.

7.4.4 Modify

CHANNEL 1oz |d
VIEW K=
ARG NO AV
J

> Using UpA Down ¥ key select the parameter value.

» Then press Enter« key to save parameter and go to
next parameter setting.

> After setting, press enterd key to save date and time.

The program can be modified in this sub-menu.

> Using UpA Down V¥ key select the channel to be modify.

» Using UpA Down V¥ key select the program number to be
modify.

> Then press Entered key to confirm program to be modified.

» As per program type, Set new values as per subsection
8.4.2.NEW.

> By pressing Entered key modified program get saved.




7.4.5 Delete
To delete single or multiple programs use this sub menu.

— Using Up & Down V¥ key select the channel which
CHANNEL civee | o program to be delete.
TELETE < Using Up A Down V¥ key select single delete or multiple
GINGLE IELETE|S delete program.

Using Up A Down ¥ key confirm delete with No/Yes
option.

Then press Enter «d key selected program will be
deleted for single delete and if selected multiple delete
then all programs will be deleted.

— > To abort Delete option, press ESC key.

DELETE NO/VES |

vV VvV V V¥V

7.4.6 End

> By using this menu, direct go to Main screen.
> To go to previous menu use ESC key.




7.5 ASTRO TIME

0 L6 112118, 2t RSTRO TIME |+
GUNRIGE R
SUNGET <-'

» This is fifth sub menu in Main Menu. By using this menu user can get information for
Sunrise and Sunset Times.

» Press Enter < key to view between Sunrise and Sunset.
> For step wise back stage use ESC 9 key.




7.6 OPTIONS

0 [ 6 , 12,18 | 24
fLBUN N 8 e E—
CRTIONG There are 6 sub menu under Options Main Menu.
Operating Hours -> Back light-> Password ->Factory Restore
->Device Info-> End
9 A VvV d
0 , 6 , 12,18 | 24 0 | 6 12,18 | 24 0o , 6 , 12, 18, 24 o , 6 , 12, 18 , 24
I / /
ORPERATING BRCHLIGHT 56W0RD
= —> —>»>

OA V J

0 [ 6 | 12,18 | 24 0 , 6 ;12,18 , 24
EnD
A VvV J A V J
7.6.1 Operating Hours

OPERATING HOURG Service
A £a

-

e J View Hour
A ]

>

service hours completed.

] after every 5 seconds.

Delete

menu. Also during service hours in progress user can clear it.
>

Enterd key, then counter is reset to zero.

’—21

This option enable user to set and monitor load service hours. After completion of service
hours, Device display alarm which can be used for maintenance or other activity.

» Here user can set operating hours, After which he
{0UR k= intend to generate alarm message.

» User can set operating hours for individual channel.

In this menu, user can check how much time of

> After completion of service hour, display shows
message "Service CH1" or "Service CH2" which flash

» To clear service message on display user need to clear service hours by using this

For deleting operating hours, Confirm the deletion by selecting “YES” and press the




7.6.2 Back light

BRCKLIGHT R
CONTINUES ON | AY
SRVETD <-' > Use Up A Down V¥ key select required option

1Min ON/ Continuous ON.
» Then press Enter« key to save format.

> 1 Min ON- Whenever there is key pressed, back light will ON for 1minute.
» Continuous ON- When Mains is ON, back light will be continuously ON.

NOTE !-Backlight remains OFF in case of power absent.

7.6.3 Password

PRGGWORT | 4
ENHELE AV » For security reason there is provision of password in
SAVED <-' time switch.
> By enabling password access to unauthorized user is
restricted.

> By default, password is disabled.

After confirming with Enter key time switch is locked with the password entered.
Whenever any key pressed device will prompt to enter the password.

User get access to menu, only when he enter correct password.

40 seconds after the last time the key was pressed the timer is automatically locked
again.

To disable password user has to enter the menu by entering correct password and using
disable option password setting can be disabled.

DISABLE-
» No any password is required to edit settings.

YVV VY

A\




7.6.4 Factory Restore

» In this Menu, user can reset all setting and programs to factory reset while RTC (clock

and Date ) remains unchanged.

AV |FACTORY RESTORE o

no/yES

RESTORE 7

J

N
LIy

> Using up A down V¥ key, Confirm restore with No/Yes then press Enter« key.
> Any settings made previously are overwritten.
» The factory settings are loaded as per below table.

SETTING DEFAULT VALUE
TIME FORMAT 24 Hours
DATE FORMAT DD.MM.YY
WEEK START DAY SUNDAY
TWILIGHT DISABLE
DST NO DST
HOLIDAY CHANNEL STATUS DISABLE
MULTIFUNCTION DISABLE
BACK LIGHT ONE MINUTE
PASSWORD DISABLE
7.6.5 End

> By using this menu, direct go to Main screen.

> To go to previous menu use ESC 9 key.




8. TECHNICAL SPECIFICATIONS

Astro Pro
AS1SCDS AS2DCDS
Supply Characteristics
Supply Voltage (@) 240 VAC 110-240 VAC
Operating Frequency 50/60 Hz
Supply Variations -20 % to +10 % (Of m )
Power consumption 5 VA 7 VA
(Max)

Battery Back up

Approx. 6 Years

Functional Characteristics

Display 6 Lines Text LCD, Viewing Angle-6 O’ Clock, Backlight- Green
Number of Programs 50 (Each channel) + 10 Holiday (Each channel)
Clock Mode Either 12 Hour (AM/PM) or 24 Hour Clock

Clock Resolution (Min)

1 Minute

Pulse Duration

1-59 seconds

Hour Setting

00-23 for 24 Hour clock and 01-12 for 12 Hour clock

Reset

Day Setting

Monday to Sunday

RTC Accuracy

+/- 0.5 sec/day @25°C

Number of Keys

4 keys [ESC, UP, DOWN, OK] & 1 RESET key

Relay Output Cha

racteristics

Contact Arrangement

1C/O 2C/O

Contact Rating

16 A (NO & NC)@ 240 VAC/24 VDC (Resistive)

Utilization Category

Max switching : 16 A (NO & NC) at 250 VAC, Cos ® =1

(AC-1)

Max switching: 10 A (NO & NC) at 250 VAC, Cos ® = 0.6

Incandescent Lamps 2600 W

Halogen Lamps 2600 W

LED Lamps <2W: 30 W

LED Lamps 2W to 8W :100W
Contact Material AgSn02

Electrical Life

50,000 cycles @ rated load

Environmental Characteristics

Operating Temperature

-15°C to +60°C

Storage Temperature

-20°C to +70°C

Humidity 95% Rh (Non Condensation)
Maximum Operating 2000 m

Altitude

Pollution Degree 2

Degree of Protection

IP-20 for Terminals ;IP-40 for Enclosure

Enclosure

Flame Retardant UL-94 VO

Other Characteris

tics

Mounting

Din Rail

Weight (Unpacked)

Approx. 1 Channel - 110gm, 2 Channel - 140gm

Operating Position

Any

Hardware reset and to be used only when device doesn't respond or hangs.




9. EMC, SAFETY & ENVIRONMENTAL SPECIFICATIONS

EMI/EMC Compliance

Harmonic Current Emissions IEC 61000-3-2 Class A
Voltage Flicker & Fluctuation IEC 61000-3-2 Class A
ESD IEC 61000-4-2 Level III
Radiated Susceptibility IEC 61000-4-3 Level III
Electrical Fast Transients IEC 61000-4-4 Level IV
Surge IEC 61000-4-5 Level IV
Conducted Susceptibility IEC 61000-4-6 Level III
Power Frequency Magnetic Field IEC 61000-4-8 Class 4
Voltage Dips & Interruption (AC) IEC 61000-4-11
Conducted Emission CISPR 11 Class B
Radiated Emission CISPR 11 Class B
Safety Compliance

Test Voltage(All Terminal to Body) IEC 60730-1 3 KV
Impulse Voltage (Input & Output) IEC 60947-5-1 Level IV
Single fault IEC 61010-1

Insulation Resistance IEC 60730-1 >7 Mohm
Leakage Current UL 508 <3.5 mA
Environmental Compliance

Cold Heat IEC 60068-2-1

Dry Heat IEC 60068-2-2

Vibration IEC 60068-2-6 10to 55Hz, 5¢g

Product Standard

IEC 60730-1 and IEC 60730-2-7




10. SERVICE CONTACT DETAILS

Product improvement is continuous process. For the latest information and special
applications Please contact GIC to reach our branch office.

CONTACT US

General Industrial Controls Private Limited.

T - 107, MIDC Bhosari,
Pune - 411026,
Maharashtra, INDIA.

Board Line: Tel: +491-20 4623 2323

International Sales: Tel: +91-20 4623 2329
export@gicindia.com

Domestic Sales: Tel: +91-20 4623 2325
marketing@gicindia.com
sales@gicindia.com

E-Waste Regulatory notice :

Kindly treat, recycle or dispose of this equipment in an environmentally sound
manner after End of Life, as per WEEE (Waste Electrical and Electronic
Equipment) regulations; or hand it over to General Industrial Controls Pvt. Ltd,

B through website https://www.gicindia.com/get-in-touch/
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